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Do you ever think you don’t have the tools or skills to make custom shape designs for your 
PowerPoint slides? Think you need fancy or expensive software or advanced design skills? 

Believe it or not, you already have everything you need! With a little creativity, this step-by-
step guide will teach you how to build custom shapes in PowerPoint that will not only spice 
up your PowerPoint slides but also help you create more compelling visuals, charts, and 

diagrams. 

You can use these shapes for a number of items, including but not limited to: 

• Custom icons 

• Image shape cut-outs 

• Custom image cropping 

• Other custom shapes for: 

o Infographics 

o Visual metaphors for processes or pipelines 

o Timeline markers 

o KPI gauges 

o Workflow visuals and swimlanes 

The list is endless! 

Let’s dive in and show you how you can use shapes to design more engaging and powerful 

slides! 

TABLE OF CONTENTS 

Use the Table of Contents below to navigate this guide. If you’re viewing this guide on a 

computer, tablet, or smartphone, you can select any item to navigate there directly. 

1. Making & Placing a New Shape 

2. Formatting a Shape 

3. Hand-Drawing Custom Shapes 

4. Editing a Shape 

5. Using the Merge Shapes Menu 

6. BONUS! Cropping Images 

Let’s get started! 

1. MAKING & PLACING A NEW SHAPE 

Before anything else, let’s start with the basics to make sure everyone is on the same page – 

making and manipulating a shape. 

1. There are two ways to add a shape: from the Home tab and from the Insert tab. Let’s 

take a look at both. 

a. Add a Shape from the Home Tab 
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i. Locate the Drawing section of the Home tab. 

ii. Choose the shape you want to draw from the Shapes dropdown menu.  

b. Add a Shape from the Insert Tab 

i. Locate the Illustrations section of the Insert tab. 

ii. Choose the shape you want to draw from the Shapes dropdown menu.  

2. Once you choose a shape, you will see that your cursor has changed to crosshairs.  

Click anywhere on the slide and hold down the mouse or trackpad.  

3. Drag your mouse or trackpad to draw the shape. The farther you drag, the larger the 

shape will be. 

4. Optionally, you can hold down the Shift key while dragging the mouse or trackpad. 

This will lock the dimensions of the shape to a 1:1 ratio – for instance, to create a 

perfect square or a perfect circle. 

5. When you’re happy with your shape, release the mouse. Don’t worry about getting it 

perfect on the first try – you can modify your shape later! 

6. If you want to manipulate the size, dimensions, rotation, location, or formatting of your 

shape, click it once to highlight it. 

NOTE: WHAT’S THAT THING AROUND MY SHAPE? 

When you select a shape, you will see a rectangular border appear around it with eight 

equal points. This is called a bounding box. It lets you see very clearly which shape(s) you 

have selected at a given time. Even more important than this, though – it also allows you to 

manipulate the shape, as listed in steps 6-10. 

7. To change the size or dimensions of the shape, click and hold any of the eight points 

of the bounding box. Then, drag in the direction you want the shape to change.  

8. Optionally, you can hold the Shift key to make it larger or smaller while keeping the 

shape’s current dimensions. 

9. To rotate the shape, click and hold the rotation icon connected to the shape’s 

bounding box. 

10. To move the shape while keeping its current shape and size, click and hold anywhere 

inside the shape or the edge lines of the bounding box (NOT the eight points). Then, 

drag the shape to the desired location. 

11. You will notice that shapes will automatically line up to other shapes using invisible 

guides. This is called snapping. These guides become visible as you drag the shape 

when it begins to line up with other items on the slide or even with the slide itself. If you 

don’t want the shape to line up with these guides, hold the Alt/Option key while 

moving the shape. 

12. Once your shape has the size, dimensions, rotation, and placement that you want, 

simply click any blank space on the slide to deselect the shape.  

13. Some shapes, such as parallelograms and stars, have additional manipulation options 

that appear in the bounding box. These are denoted by an additional ninth point 

inside the bounding box. 
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a. In the case of the parallelogram, by clicking and dragging this point side to side, 

you can change the steepness of the angled edges. 

b. In the case of a star, by clicking and dragging this point up and down, you can 

change the width of the arms of the star. 

c. Any time you see these additional points, drag them around to experiment and see 

what they do! If you ever don’t like the changes you made, simply use the 

keyboard shortcut Ctrl+Z/Cmd+Z to undo the change. 

And that’s it! Remember that just because you’ve deselected the shape doesn’t mean you 

can’t select it again later to manipulate it further. 

2. FORMATTING A SHAPE 

Now that you’ve got your shape where you want it, as well as the correct size, dimensions, 

and rotation, it’s time to start thinking about the formatting – namely, the colors and any 

special effects it might have. 

Before starting, keep in mind that in many organizations, the colors you can choose from to 

use for your shapes may likely be predetermined by your company’s brand guidelines. Some 

companies have these colors built into their PowerPoint templates, which you may even be 

using right now! But if not, you can search your company’s intranet page to see if the brand 

guidelines have been posted, or if not, you can contact your Marketing team for further 

assistance. This is especially important if you’re making a PowerPoint for a large audience, 

senior leadership, or that will be viewed externally outside the company.  

1. Click the shape to select it. Note that the shape will be selected when the bounding 

box – or the rectangular border with eight points – appears around it. 

2. There are two ways to change the formatting of a shape. 

a. Change the Formatting Using the Shape Format Tab 

i. When you click a shape, click the new tab that appears on the toolbar called 

Shape Format. 

NOTE: This tab only appears when a shape is selected. If you aren’t seeing this 

tab, it means you either haven’t selected your shape per step 1, or you have 

selected a different item by mistake, such as an image. 

b. Change the Formatting Using the Format Shape Panel 

i. Right-click the shape you want to format. 

ii. From the dropdown menu that appears, choose Format Shape. 

iii. The Format Shape panel will open on the right-hand side of your screen. Often, 

the Fill & Line button will be selected by default, but if it isn’t, you can click it 

now. 

iv. For the purposes of this guide, we will talk about how to format shapes from the 

Format Shape panel, as there are additional options available there that aren’t 

available from the Shape Format tab. 
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3. You will see several options for changing the formatting of your shape. For the 

purposes of this guide, we’re going to focus on these three: Shape Fill, Shape Outline, 

and Shape Effects. 

4. SHAPE FILL: Shape Fill refers to the color of the shape itself. You have a number of 

options for how you can fill the shape. 

a. No Fill: You can take away the color of the shape entirely, making it fully 

transparent. To do so, click the No Fill radio button. 

b. Fill with a Color: First, choose the Solid Fill radio button. Then, you can choose a solid 

color from the menu of colors provided or choose any color you want from the 

More Fill Colors panel. If your company provides branded colors, enter the RGB 

(Red, Green, Blue) numbers here, or use the 6-digit hex code. You can also change 

the Transparency of the shape to make it translucent or fully opaque.  

i. You’ll notice as you choose custom colors that they will appear in the Recent 

Colors row beneath the color menu. This makes it easy to pick the same colors 

again once you’ve chosen it the first time. 

c. Fill with the Eyedropper: To match the color of the shape to another item on your 

slide, use the Eyedropper tool. With the Eyedropper selected, click the color on 

another item on your slide and watch the shape fill with the exact same shade! This 

is great if you want to match a shape to an exact color on an image.  

NOTE: Anything you want to color-match must be on the slide with the shape. For 

instance, if you want to use a color from a picture on a webpage, you must first 

download the image from the webpage, insert it into your slide, and then color-pick 

the color you want from there. 

d. Fill with a Gradient: To fill the shape with more than one color, select the Gradient Fill 

radio button. You can choose from the list of premade gradients or make your own. 

Use the slider to place your Gradient Stops (where each color will start). You can 

change the color of each Stop marker with the Color dropdown, as well as toggle 

the transparency of each item. You can modify the type of gradient (Linear, Radial, 

etc.) the direction of the gradient, and the angle. 

e. Fill with a Picture or Texture: To fill the shape with an image or texture, choose the 

Picture or Texture Fill radio button. You can insert a picture using the Insert button. A 

popup menu will appear asking you where on the computer you want the picture 

to come from. You can choose a picture from a File on your computer, from a free 

Stock image library in PowerPoint, and more! Alternatively, you can choose a 

premade texture from the Texture dropdown menu. 

f. Fill with a Pattern: To fill the shape with a pattern, choose the Pattern Fill radio 

button. You can choose from a number of patterns and change the foreground 

and background colors. 

g. To Match the Fill of the Shape to the Background: Choose the Slide Background Fill 

radio button to change the color of the shape to match the color of the slide’s 

background. 

5. SHAPE OUTLINE: Shape Outline refers to the outline of the shape. You have a few 

options for the shape outline. 
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a. To Remove the Outline Entirely: You can choose for your shape to have no outline 

at all by clicking the No Line radio button. 

b. To Create a Solid Outline: A “solid” outline simply refers to the color of the outline – 

that the outline will be only one solid color, as opposed to a gradient of colors. 

Dotted lines, dashed lines, and sketched lines can all be either solid or gradient 

outlines. Start by choosing the Solid Line radio button. Then, choose the color and 

transparency for the line. You can increase the line thickness using the Width ticker. 

You can make dotted and dashed lines by choosing from the Dash Type dropdown 

menu. To make dots round or squared, change the Cap Type to round or flat, 

respectively. Play with all the other options available to create unique effects! 

c. To Create a Gradient Outline: A gradient outline has all the same styling options as 

a solid outline except that it allows you to have more than one color across the line. 

Just like with the gradient fill, use the Stop markers to determine where each color 

begins. 

6. SHAPE EFFECTS: You can add all sorts of effects to a shape to give it different 

properties that make it stand out from the slide, appear to be highlighted, stylize it, or 

otherwise draw attention to it. Let’s look at what’s available in PowerPoint. To access 

all the Shape Effects options, click the Effects button in the Format Shape panel under 

the Shape Options. 

a. Add a Shadow: A shadow can give a shape the illusion of being three-dimensional 

or appear to be jumping off the page. To add a shadow, start by choosing the 

option from the Presets dropdown menu that best matches the look you want. 

Once you choose, you can change the color of the shadow, how transparent or 

opaque the shadow is, its size, how blurred or sharp it is, its angle, and how far it is 

from the shape. 

b. Add a Reflection: A reflection can give a polished or high-tech effect to a slide, 

making it appear as though a shape is sitting on a shiny surface like glass or marble. 

To add a reflection, start by choosing the option from the Presets dropdown menu 

that best matches the look you want. Then, change how transparent or opaque the 

reflection is, how far down the reflection goes, how blurred or clear the reflection is, 

and the distance the reflection is from the bottom of the shape.  

c. Add a Glow: A glow can highlight a shape or make it appear as though the shape 

is emitting light. To add a glow, start by choosing the option from the Presets 

dropdown menu that best matches the look you want. Please note that Glow 

presets have a set option of colors, but you can change the color to anything you 

want by using the Color dropdown menu. You can also change how widely the 

glow emits from behind the shape as well as how transparent or opaque it is.  

d. Soften the Edges: The Soft Edges option adds a feather effect to the outer edges of 

the shape – or in other words, takes away the harsh edges of the shape by making 

the very edges fully transparent and making the shape more opaque as it makes its 

way inward. It’s a great option for creating a smoother transition with the items 

behind the shape while still leaving the dimensions of the shape intact. Start by 

choosing the option from the Presets dropdown menu that best matches the look 

you want. Then, change how far into the shape the transparency reaches. 
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e. 3-D Format & 3-D Rotation: While they don’t have to be used together, the two 

items tend to go hand-in-hand. Both add elements like beveling, lighting effects, 

material effects, and rotation effects that make the 2-D shape in the slide appear 

more three-dimensional. 

Combining different fills, lines, and effects can turn any boring shape into something special! 

Experiment with all the different options available to see what you can create!  

3. HAND-DRAWING CUSTOM SHAPES 

You aren’t stuck using only the premade shapes PowerPoint has in their Shapes dropdown 

menu. There may be times where you want a particular curve or geometric shape. 

Let’s look at how to do both. 

1. Making a Custom Curve 

a. In the Shape menu, choose the Curve tool. 

b. On the slide, click where you want the curve to begin. 

c. Each click will denote where the peaks and troughs of each curve will be. When 

you click the first time to begin drawing the curve, you’ll see that it appears to begin 

a straight line. 

d. Move your cursor up to make a peak and down to make a trough. Then, click 

where you want the point. The line being drawn will automatically change to a 

curve. 

e. Continue clicking to make a curve with several points, or you can stop after just one 

or two clicks depending on your desired outcome. 

f. When you’re finished making your curve, hit the Esc key on the keyboard to finalize 

the shape. A bounding box will appear around the shape, signaling that the 

creation of the shape is complete. 

2. Making a Custom Geometric Shape 

a. In the Shapes menu, choose the Freeform: Shape tool. 

b. On the slide, click where you want to put the first point of the shape.  

c. Each click will create a point in the shape. Continue clicking to make a geometric 

shape with several points. 

d. To lock each segment to 45° increments – including perfectly vertical, horizontal, or 

diagonal lines – hold the Shift key before clicking. You will see the line lock in the 

direction you’re dragging it. 

e. When you’re finished making your shape, you can create a fully closed shape by 

returning to the first point and placing your last point in the same spot. If you want to 

leave the shape open, you can hit the Esc key to finalize the shape at any time. 

If you don’t like where the points are of your curve or geometric shape, don’t worry! In the 

next Section, we’ll discuss how to edit your custom shape, as well as any others you make 

from the Shape menu. 
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4. EDITING A SHAPE 

Perhaps you made a custom shape but don’t love how it turned out. Or maybe you made a 

pre-formed shape from the Shapes menu but need to adjust one particular point. 

PowerPoint has a built-in shape editor that allows you to modify a shape point by point – not 

the points of the bounding box but the vertices or curves of the shape itself. 

1. Start by selecting the shape you want to edit. 

2. The Shape Format tab will appear in the toolbar. Click the Shape Format tab. 

NOTE: This tab only appears when a shape is selected. If you aren’t seeing this tab, it 

means you either haven’t selected your shape per step 1, or you have selected a 

different item by mistake, such as an image. 

3. In the Insert Shapes section, click the Edit Shape dropdown menu.  

4. From here, you can use the Change Shape menu to turn the current shape into any 

other pre-formed shape. 

5. For this example, though, let’s click the Edit Points option, which will allow us to do 

freeform editing. 

6. You will see that the bounding box around the shape has disappeared. In its place, 

the shape’s edges have each been highlighted, and new editable points have 

appeared at each of the shape’s vertices. These are called edit points or anchor 

points. You may also hear Bezier points, which refer to the points at the peaks and 

troughs of curves. In this guide, we’ll call them edit points. 

7. To edit the shape, click any of the edit points once to highlight it. When you highlight it, 

two more points will appear nearby. 

8. From here, you have two options: 

a. You can click and drag the edit point in any direction to place that point 

elsewhere. 

b. You can use the two new points to turn this point into a curve (or edit the curve if it 

already is one). Each of these points is actually a lever, which pull the line into a 

convex position or push it into a concave one. To make the line even smoother, you 

can click the next edit point in line and adjust its levers, too. 

9. Once you’re happy with the changes to your shape, click any blank area of the slide 

to deselect the shape. 

You may find that freeform editing shapes takes some getting used to, but with practice, you 

can make almost any shape you want! Same thing with editing curves – everyone 

accidentally makes abstract art the first few tries! 

5. USING THE MERGE SHAPES MENU 

Now, let’s get into some true shape-building techniques. 

Shape building is one of the simplest secrets in graphic design. Have you ever wondered 

how designers create those flashy, custom icons and how they seem to have an icon for 

every occasion? While shape building isn’t the only way, it’s one of the easiest and fastest!  
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Shape building is the art of combining simple shapes – like circles, squares, and triangles – to 

make all kinds of complex shapes that would otherwise take a lot of effort and skill to create.  

While some illustration tools have more robust features, those available in PowerPoint have a 

wide range of uses and are likely enough for whatever project you have in mind! 

1. Start by deciding what shape you’re trying to make. This may seem like a silly step – of 

course you should know what shape you’re making before you try to make it! But 

properly planning a shape is one of the most important steps in the process. In order to 

build complex shapes, you have to be able to break it down into its simpler 

components. To do that, you have to know what you want to build in the first place. 

For the purposes of this tutorial, I’m going to keep it simple: we’re going to create a 

rounded rectangle with one fully rounded side and one squared-off side. 

2. Build the shapes you need. In this case, I need a circle and a rounded rectangle.  

3. Line up your shapes. You must be PRECISE at this step – lining up your shapes cleanly 

now will ensure they merge together exactly the way you want later! For instance, I 

need to make sure my shapes are overlapping at precisely the right areas and that no 

part of either shape is hanging off the outer edge. 

TIP: You may find it helpful to make each shape a different color when lining them up – 

something unique from each other as well as different than the background color. This way, 

you can easily see where the edges of each shape are and where there is good or bad 

overlap. Another method of this is to make the shapes translucent so you can see where the 

overlap is. Still another method is to keep the outlines on the shapes. Play around with this to 

find the way that works best for you! 

4. Once your shapes have been placed where you want them, you’re ready to build 

them into one shape! To do this, you must first select both shapes. Click one of your 

shapes. Then, hold the Shift key and click the other shape. This will highlight both at the 

same time – a bounding box will be visible around both. 

NOTE: Where the shapes are on the slide isn’t important. Once you’ve created your 

final shape, you will be able to move it around, scale it, rotate it, or otherwise modify it 

the same way you did with single shapes (see Section 1, MAKING & PLACING A NEW 

SHAPE, for more details). 

5. Click the Shape Format tab in the toolbar, which appears when you click the first 

shape. 

NOTE: This tab only appears when a shape is selected. If you aren’t seeing this tab, it 

means you either haven’t selected your shape per step 1, or you have selected a 

different item by mistake, such as an image. 

6. In the Insert Shapes panel, click the Merge Shapes dropdown menu.  

7. You’ll see that there are several options for shape building here. Let’s look at what 

they each do: 

TIP: Hovering over each option will show you a preview of how it will combine or cut out your 

shapes. 

a. To Combine Two Shapes: To make the shape mentioned at the beginning of this 

Section – a rounded rectangle with one fully rounded side and one squared-off side 
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– click the first option, Union. Both shapes will be combined into one. This is 

especially apparent if you have the outlines of the shapes turned on – you will see 

the outline on the two shapes change to an outline on one, signaling that the shape 

has been combined. 

b. To Cut Out the Overlapping Portion of the Shapes: When you click the Combine 

option, you’ll see that the portion of the shapes overlapping in the middle is cut out 

and deleted. This is especially apparent if you have something behind the shapes – 

you can see that the middle portion is now gone and what is underneath is now 

visible in the resulting hole. 

c. To Create a Shape from the Overlapping Portion and Keep All Three Shapes: When 

you click the Fragment option, it will at first appear as though nothing has 

happened; however, you will now have three shapes on the slide: the two original 

ones, plus a third for the portion of the shapes that was previously overlapping. This 

option punches out the overlapping shape but leaves all three shapes on screen.  

d. To Create a Shape from the Overlapping Portion Only: When you click the Intersect 

option, the two original shapes will disappear. In their place, only the overlapping 

portion will be left behind. 

e. To Delete One Shape from Another: This one is a little trickier than the others 

because it requires you to select your shapes in a certain order before cutting them 

out. When you click the Subtract option, one shape will be subtracted from the 

other, leaving just a piece of one shape – the part not overlapping the other – 

behind. Whichever shape you click first will be left behind; the shape you click 

second will be deleted from the first and will disappear altogether. You’ll be left with 

the first shape clicked but only the portion not overlapping the second shape. 

8. Once you’ve built a shape, you can use it to build more shapes and so on. For 

instance, let’s say I want to cut a star out from my rounded rectangle (made using the 

Union option from step 7a above). If I build a star on top of the shape, I can use the 

Combine or Subtract option in this case to punch out the star shape. You can see how 

the background is now visible within the star. 

The possibilities with shape building are truly endless! Try out all different combinations to get 

all sorts of results! 

6. CROPPING IMAGES 

Sometimes rather than a shape, you may want to use an image as a decorative asset, 

manipulating its edges either to crop it into a particular shape or cut a shape out of it. Let’s 

take a look at both options! 

1. Cropping an Image into a Particular Shape 

TIP: Cropping an image into a shape is especially useful for times when you want an image 

to appear inside a perfect square or circle, such as for an introduction slide.  

a. First, drag and drop the image you want to manipulate from your desktop folder 

onto your slide. You can also navigate to the Insert tab, click the Pictures dropdown 

menu, and click This Device to find and insert your image that way.  
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b. Click your image to select it. You will know it’s been selected when the bounding 

box appears around it. 

c. Once selected, the Picture Format tab will appear in the toolbar. Click the Picture 

Format tab. 

NOTE: This tab only appears when a picture is selected. If you aren’t seeing this tab, 

it means you either haven’t selected your picture per step 1b or you have selected 

a different item by mistake, such as a shape. 

d. In the Size panel, click the Crop dropdown menu. 

e. There you will see several options. For this guide, we will cover two: Aspect Ratio and 

Crop to Shape. 

i. ASPECT RATIO CROP: This crop option allows you to choose a width-to-height 

ratio for your image. The 1:1 ratio is especially useful – it lets you crop an image 

into a perfect shape (square, circle, etc.) per step 1eii without any distortion. If 

the proportions of the image don’t matter, this step is not necessary to 

complete before cropping to a shape. 

ii. CROP TO SHAPE: This crop option allows you to turn the photo into any of the 

pre-formed shapes in the dropdown menu. 

• Click the desired shape from the dropdown menu. 

• The picture will automatically be cropped to that shape using its current 

width-to-height proportions (hence, if you want a 1:1 shape or any other 

ratio, follow step 1ei first). 

2. Cutting a Shape out of an Image 

a. This process is the same as cutting a shape out of another shape as covered in 

Section 5 of this guide, USING THE MERGE SHAPES DROPDOWN. 

b. To start, create the shape you want to cut out of the image. Modify the shape in 

size, dimensions, and rotation as needed (reference Section 1, MAKING & PLACING 

A NEW SHAPE, for the steps of this process). 

c. Place the shape in the exact place where you want to cut out the image. Be sure it 

is properly lined up and sized, as this is exactly how the shape will be cut out.  

NOTE: Where the image and shape are on the slide isn’t important. Once you’ve 

created your final image, you will be able to move it around, scale it, rotate it, or 

otherwise modify it the same way you did before cutting out a shape (see the 

MAKING & PLACING A NEW SHAPE Section for more details). 

d. Select the image behind the shape or text FIRST. Then, hold the Shift key and select 

the shape SECOND so both items are selected. When you see a bounding box 

appear around both items, you will know both are selected.  

NOTE: This order is EXTREMELY important. If you select the items in the opposite order, 

this process will not work correctly. 

e. Because you have both a shape and a picture selected, the Shape Format and 

Picture Format tabs will appear in the toolbar. For this process, click the Shape 

Format tab. To help you remember, this process falls more into the realm of shape 
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building – we are doing the same steps here as we did when shape building with 

two shapes – so therefore, we need the Shape Format tab. 

f. In the Insert Shapes section, click the Merge Shapes dropdown menu.  

g. Hover over each of the items to see which effect you want to create. For more 

information on each of the options, reference Section 5, USING THE MERGE SHAPES 

DROPDOWN. 

As you can see, the options for what you can do are limited only by your creativity! There are 

many, many uses for this function – experiment to determine what works best for you! 


